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Introduction 

Transactional applications development has always required the integration of the often-
conflicting interests of data server design and application design. This does not change with three-
tier component-based J2EE applications based on Business Components for Java (BC4J). This pa-
per examines how Oracle9i Designer and Oracle9i JDeveloper can be used together to deliver an 
effective database applications development environment 

Application Development today 

Approaches 

Using today’s modern development tools, there are a number of different approaches to profes-
sional application development: 

•  Hand-code 
•  Component-based architectures 
•  Declarative rapid application development (RAD) tools 
•  Model-based development 
•  Custom Accelerators 

Hand-code 

You can hand-code using 3GL-type languages such as Java and C++, most probably using a pow-
erful integrated development environment (IDE) that will contain coding tools such as profilers, 
debuggers, compilers, and deployment utilities. This approach is supremely flexible, but is costly 
in terms of resources and quality: lots of programmers writing lots of code will create lots of bugs, 
no matter how talented or conscientious they are.  
This then forces development organizations to curtail the development lifecycle early so as to in-
crease the number of testing and bug-fixing iterations; with perhaps as much as three to four 
months of each development cycle being taken up with QA, code ‘polishing’, and bug-fixing. With 
the recent emphasis on accelerating time to market, and the concomitant decrease in the time be-
tween software releases, we see pressure being applied to the amount of time devoted to actually 
coding new features! 

Oracle9i JDeveloper: Java & XML Coding  
Oracle currently provides the technologically advanced JDeveloper IDE to fulfill the Java coding 
environment need. Full Java language and end-to-end XML support, coupled with the capability to 
support a number of deployment and middle-tier architectures (JSP, Servlets, EJBs, CORBA Ob-
jects) and some significant productivity tools have made it the tool of choice for many Java soft-
ware engineers. 

Component-based architectures 

An additional overhead from which the hand-coding approach suffers is the mismatched interfaces 
of today’s object-oriented coding languages and the data persistency richness and robustness af-
forded by the modern relational database. 
A powerful solution to this problem can be found by employing an architecture based on compo-
nents to provide the ‘glue’ between the 3GL programs and the relational database. This technique 
of using ready-made components affords an increase in programmers’ productivity while still 
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maintaining a large degree of flexibility. When the component architecture is standardized, and 
developed and maintained as a software product itself, it becomes an extremely powerful tool in 
the struggle for productivity and quality. J2EE is just such an architecture. 

Business Components For Java: Component Development  
As ever though, the flexibility of a generic standard is always compromised by its very nature, and 
it is with that in mind that Oracle developed Business Components For Java (BC4J). These soft-
ware components augment and integrate with J2EE components to provide a robust framework that 
supports the kind of rich relational database interaction that you would expect from the world’s 
leading database supplier. Predictably, BC4J is an integral part of JDeveloper, the IDE providing a 
number of wizards that make the creation of the BC4J components extremely easy The BC4J 
framework however has been designed to be server-agnostic, and is completely open, thus provid-
ing a ‘white box’ approach, as opposed to the proprietary ‘black box’ approach. 

Declarative RAD tools 

RAD tools have been with us for many years now and provide us with the ability to define how a 
particular software item will behave at certain events, to define declaratively using sets of proper-
ties how it will look in the user interface (UI).  
These tools radically increase productivity, the amount of code required being slashed. However, 
there is a trade off in terms of flexibility, as the underlying enabling software will always restrict, 
to a greater or lesser extent, the ability of the software engineer to do whatever they want. 

Oracle9i Forms: Declarative 
Oracle9i Forms is classic RAD tool. Evolved over many years, it has been used extensively by lit-
erally hundreds of thousands of developers worldwide (including notably Oracle Applications E-
Business Suite) to develop richly interactive applications that are tightly integrated with the rela-
tional database.  

Model-based development  

Developing application systems using graphical models, and then generating significant quantities 
of code from these models, has been a technique available to application developers for many 
years. The variety and scope of these models, and the quantity, quality, and completeness of the 
generated code varies from tool to tool, but the result is always the same; productivity is increased.  
However, wherever code generation is employed, the engineers who wrote the generators will have 
had to analyze the requirements and create generic set-piece structures that can then be fleshed out 
with the context at generation time. No matter how complete the analysis, or the capability of the 
generator; you will always lose flexibility against the hand-coded approach. In the vast majority of 
cases, this is ameliorated by the huge gains in productivity and quality. 

Oracle9i Designer: Modeling & Generation 
Designer has been Oracle’s application development modeling tool since the late ‘80s and supports 
a number of modeling techniques that have been developed over the last 15 to 20 years. From sys-
tems analysis techniques such as entity relationship modeling and process modeling, to server de-
sign, generation, and capture, and program generators such as the Forms Generator, Reports Gen-
erator, and Web PL/SQL Generator, Designer has a proven track record as one of the world’s lead-
ing modeling and generation tool. 

Custom Accelerators 

To offset the issue of gains in productivity leading to loss of flexibility, and of course vice versa, 
there is the possibility of extending the model-based and declarative solutions with generic frame-
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work code, templates, and patterns that can be customized during design and build. This provides 
in effect a kick-start to a project so that much of the architectural groundwork has already been 
done. You get the benefit of productivity enhancing modeling and generation while regaining the 
flexibility of component- or pattern-based architectures.  

Oracle Designer BC4J generator 
The Oracle Designer development team has worked on a framework that provides a mechanism to 
take existing Designer artifacts and generate BC4J components from them. This is a powerful ca-
pability that gives Designer users a step up into the world of JDeveloper and Java development.   
Figure 1 summarizes the issues discussed above, and illustrates how custom accelerators can claw 
back some of the flexibility relinquished in the search for productivity 
 
 

 
Figure 1: Application Development Approaches 

Configuration Management 

One of the common requirements of application development in any environment is the need to 
support team-working and versioning. 
With the 6i release of Designer, Oracle introduced file support, versioning (check in and check 
out), and configuration management (branching, merging, release) into the Designer repository. 
This technology has been extended to support Oracle’s other developments tools, most notably 
Forms and JDeveloper. 
This has led to the evolution of a new tool, Oracle Software Configuration Manager (SCM). 
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How Does Oracle9i Help? 

What is Oracle9i? 

Oracle9i is an integrated set of products that provides the complete solution to the application de-
veloper: 

•  Oracle9i – the database: the most powerful and robust object-relational database in the 
world today.  

•  Oracle9i Application Server – 9iAS: a complete and integrated set of components, tools, 
and servers to enable J2EE application deployment, multi-tier portal applications, and the 
rich Java UI of Oracle Forms. 

•  Oracle9i Developer Suite – 9iDS: the tools that support the database and create the appli-
cations that run on the servers. 

The main goals of the Oracl9i platform are to provide software products that are: 
•  Complete 
•  Integrated 
•  Standard 

What is 9iDS? 

The components of 9iDS can be viewed in two main functional areas: 
•  Business Intelligence tools (BI) 

o Reports Developer  
o Discoverer Administrator  
o Warehouse Builder  
o Clickstream Intelligence Builder 
o BI Beans 

•  Rapid Application Development tools (RAD) 
o Designer  
o Forms Developer  
o JDeveloper and BC4J 
o Software Configuration Manager (SCM) 
o Developer's Kits 

This paper is concerned with the Designer and JDeveloper tools. 

Oracle9i Designer 

The 9iDS release of Designer is a consolidation of the existing Designer 6i against the new soft-
ware stack. Oracle9i Designer designs, generates, captures, and installs into an Oracle9i database. 
It co-exists in the same Oracle Home as the other 9i products, and generates and captures the sister 
tools in the suite: Oracle9i Forms and Oracle9i Reports. Generated Web PL/SQL application runs 
on a 9iAS V2 server. 
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Oracle9i JDeveloper 

The 9iDS release of JDeveloper has undergone some sig-
nificantly more fundamental improvements, and, as illus-
trated in figure 2 (on the next page) provides an end-to-
end tool for developing J2EE applications in an enterprise 
environment. 
The entire IDE has been recoded in Java, and the tool 
boasts full support for the J2EE environment and full in-
tegration with the 9iAS Java solution Oracle9iAS Con-
tainers for J2EE (OC4J).  
For the first time the IDE has UML Modeling compo-
nents. These support Class modeling, Activity modeling, 
Java code generation and synchronization, and Enterprise 
Application Integration (EAI) with the generation of Ora-
cle AQs and Workflow. 
For the Java programmer there are new profiling, editing, 
and debugging tools, and a refactoring tool called Code-
Coach that makes suggestions for coding improvements. 
There is also richer support for Java Server Pages (JSP), 
BC4J, and XML. 
Database integration has also been enhanced and, in addition to the existing configuration man-
agement support for Oracle SCM, there is now support for Rational ClearCase and Gnu CVS. 

UML Modeling 

Oracle9i JDeveloper supports two types of modeling technique: 
•  Class Modeling 
•  Activity Modeling 

Class Modeler 

The Class Modeler supports all the UML notation that you would expect:  
•  Java Classes 
•  Interfaces 
•  Domains 
•  Packages 
•  Associations (directional and non-directional, strong and weak aggregation) 
•  Generalization 
•  Realization 
•  Dependency 

It also supports the modeling of BC4J Entity Objects (EOs). These objects map directly to rela-
tional tables in the database, and are one of the fundamental classes you need to create when de-
veloping a BC4J application. You can either create EOs in a diagram then generate the resulting 
tables to the database, or more typically, capture the structure of the table from the database and 
create the EO in a diagram. This process will also capture key constraint information, with foreign 
key constraints resulting in EO associations in the resulting model. 

Figure 2: Oracle9i JDeveloper at a glance
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Code Generation and Synchronization 
Possibly the most powerful feature of the Class Modeler is its ability to generate Java from a 
model, and then maintain synchronization between the code and the model from then on. In fact 
you don’t have to start with a model. You can create the model from the code. This is sometimes 
known as reverse engineering the model. 
The synchronization is two-way:  

•  When you change the model, the code is updated 
•  When you change the code, the model is updated 

With the BC4J EO model, the Class Modeler also generates an XML meta-data model, and this too 
is kept synchronized with the model. 

Activity Modeler 

The Activity Modeler models e-business process and objects states, and supports the following 
UML elements and structures: 

•  Activities 
•  Object states 
•  Transitions 
•  Pseudostates (initial, final, forks, joins) 
•  Swimlanes 

In addition to this generic activity modeling capability, the Activity Modeler has been extended to 
support and generate Enterprise Application Integration definitions that support Oracle AQ and 
Oracle Workflow.XML, SCM, AND XMI 

Both the Class Modeler and Activity Modeler store their artifacts as XML definitions; there being 
one file for each object in a model (Java Class, Objects State, and so on), and one for each dia-
gram.  
Oracle9i JDeveloper supports three major configuration management products: 

•  Oracle SCM 
•  Rational ClearCase 
•  Gnu CVS (http://www.gnu.org/software/cvs/cvs.html) 

Because of this full integration, the entire IDE, including the modeling tools, supports team work-
ing. 
Oracle9i JDeveloper currently supports import from the following UML modeling tools using XMI 
standards: 

•  Rational Rose 
•  TogetherSoft TogetherJ 

If you have been developing class or activity models using either of the above tools, then it is fairly 
straightforward to migrate them to JDeveloper to take advantage of the IDE and code generation 
and synchronization features.  
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Oracle9iDS: A New Modeling Approach 

Overview 

For the first time Oracle has products that support the traditional Information Engineering ap-
proach to modeling, as well as the latest UML approach, in an integrated package: Oracle9iDS.  
People will need to use Designer to develop and maintain their relational database server objects, 
the persistence medium of choice for the majority of data-oriented J2EE application. They will 
also need to use JDeveloper to model, generate and code for J2EE, using BC4J to enable the ob-
ject-relational mapping to the server objects. 

Use Cases 

This section of the paper contains a number of use cases that outline how Oracle9i Designer and 
Oracle9i JDeveloper might be used ‘in concert’ as it were to support a number of different applica-
tion development problems. 

1. I have a Designer server model on which I want to build BC4J 

The database design is being developed in Designer and the decision has recently been made 
to opt for a J2EE application architecture. 

•  Iteratively generate the database design to support the application. This may consist of any of 
the relational objects and code currently supported by Oracle9i Designer, including PL/SQL 
objects (packages, procedures, functions), object types, database triggers, and so on. 

•  Capture the data structures into JDeveloper as BC4J EOs. You will be able to capture ta-
bles, database views, synonyms, materialized views, columns, primary keys, foreign keys 
(see figure 3 below). This process also creates an XML file and Java class for each EO, 
and an XML file for each EO association. 

•  Then generate the remaining BC4J components (View Objects and Application Modules) 
using the Business Components generator. This process creates a View Objects (VO) for 
each EO (consisting of an XML file and a Java class) and one Application Module (AM) 
per package (also consisting of an XML file and a Java class). 

 
Figure 3: The table to Entity Object mapping 
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This use case could also apply to a complete system that has been developed over a number of 
years, perhaps using Forms as the UI. The decision has been taken to migrate the current archi-
tecture to a J2EE implementation, while leaving the data model relatively untouched. 

2. I have a database that I want to visualize and refine before I start my BC4J develop-
ment 

The database is a legacy system that may even be in a non-Oracle database.  
•  Create an application system in Designer and capture the database objects into it. You will 

be able to capture virtually everything from the legacy server that you need to. 
•  Visualize the database design on a server model in Designer. 
•  Refine the design using Designer server modeling, and then generate it into a new data-

base, or indeed the existing one. If you select the latter option, the Server Generator will 
analyze the existing database objects, identify the differences, product a report, and gener-
ate ALTER TABLE statements rather than dropping the table and recreating it. 

•  Create the BC4J components as detailed in use case #1 above. 

3. I have been developing in JDeveloper 3 and I want to verify my database design 

Both JDeveloper 3 and Oracle9i JDeveloper allow you to create database objects from your 
EO definitions. This is an extremely useful capability, although limited; you cannot create 
much more than tables, columns, and keys.  
•  Generate the database from the EO definitions in JDeveloper. 
•  Capture the table, column and key definitions into Designer as detailed in use case #2 

above. 
•  In Designer, visualize, verify and if necessary modify the table design. 
•  Add the required physical design objects, such as indexes, sequences, views, and DBA ob-

jects such as tablespaces, users, grants, and so on. 
•  Generate the completed database objects. 
•  Refresh the original EO definitions in JDeveloper. 

� Edit the EO in the diagram 
� Navigate to the Attributes tab and click the New from Table…or the Synchronize but-

ton. 
� Select any new columns that you added in Designer and generated into the database 

Pressing OK will update the existing EO XML and Java class files. 
•  Modify the VO and AM objects to reflect the use they may make of any new columns. 

4. I am working on an EAI project and I want to manage dependencies on my Oracle Ad-
vanced Queues 

The Activity modeler in Oracle9i JDeveloper can create Oracle Advanced Queues as part of an 
EAI solution. These are generated directly into the database and you might wish to manage 
them in Designer so that you can make use of Oracle SCM’s sophisticated Dependency Analy-
sis capabilities. 
•  Generate the AQs from JDeveloper 
•  Capture the AQs and their associated queue tables into Designer. 
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5.  I have been developing my UML models in another tool and I want to generate a robust 
persistency model 

Oracle9i JDeveloper supports the import of class model components from another XMI com-
pliant tool. If you have created class models in either Rational Rose or TogetherSoft TogetherJ 
then you will be able to migrate the UML and XMI compliant artifacts from the source tool to 
JDeveloper Class Modeler. 
•  Generate an XML export file containing the XMI data from the source tool. 
•  Create an empty project in JDeveloper. 
•  Create a new UML diagram in the empty project. 
•  Select Class Diagrams from XMI Import then click OK. 
•  Select the XML file containing the XMI that has been exported from your other modeling 

tool and click Open. One class diagram is created for each package in the model, and one 
diagram is created for all the other elements that are not in a package, for example, those at 
project level. Relationships, such as associations, generalizations and realizations, between 
packages in the model will not be drawn on the diagrams. 

6. I want to use a single SCM system for my Designer and JDeveloper artifacts 

As soon as a development team grows beyond a few engineers, it is likely that you will want to 
pursue a configuration management solution that prevents files that one person is working on 
being compromised by another. Oracle9i JDeveloper now supports three SCM systems, and 
there are plans to support more in the future. Designer only supports Oracle SCM. 
•  In Designer, enable versioning using the Repository Administration Utility (RAU). 

o Options > Enable Version Support … 
•  In JDeveloper, enable source control from the File menu 

o File > Source Control > Enable 

o Create a new connection in the Oracle9i SCM node in the JDeveloper navigator.  

 

Figure 4: Enabling Source Control in JDeveloper 
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7. I want to leverage my Designer module definitions in the J2EE world 

Designer has rich schema and program module meta-models from which you can generate 
complete applications. These meta-models share semantic similarities with the BC4J model. 
Oracle Development has been developing the Designer BC4J generator.  This technology con-
sists of generators to pull information from the Designer schema and module elements, and 
then create Java within the BC4J framework in JDeveloper. The model is 'pull' rather than 
'push'. 

Sharing Repository Definitions 

Given the previous use cases, a rich Designer model (from which you may already have been gen-
erating complex Forms applications), and the flexibility of the Designer BC4J Generator, it is con-
ceivable that a J2EE application development project could not only make use of the Designer ta-
ble and module definitions, but could share them with an ongoing Forms generation development.  
 

  

 

Where do we go from here? 

Oracle9i Designer: Post 9i 

With the Oracle9i stack stabilized in the first release of Oracle9i Designer, we plan to create some 
new features Designer post 9i. There will be better support for existing database objects, further 
support for new Oracle9i database objects and structures and some much-requested enhancements 
to the Web PL/SQL generator and the Database Design Transformer. 

Figure 5: Developing Forms and J2EE applications from a common model 
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Oracle9i JDeveloper: Post 9i 

In the same timeframe, we are intending to make the UML support in JDeveloper both broader and 
deeper: 

•  More modeling techniques: 
o Use case Modeling 
o Sequence Modeling 
o Server Modeling 

•  Wider XMI support 
•  More Class Modeling Profiles: 

o EJB Modeling 
o Web services Modeling 

•  Richer BC4J modeling: 
o View Objects 
o Application Modules 

BC4J Generation From Designer  

Oracle Development has developed an extensible transformer framework to enable the develop-
ment of, not just schema and module transformers, but other transformers as well. 
It is intended that this framework will also support custom transformers that could be developed by 
partners. 
The first of these transformers will provide BC4J Generation, and will in outline generate the fol-
lowing mappings and BC4J components: 

•  Table Definitions > Entity Objects 
•  Module Components > View Objects 
•  Module Definition > Application Module 

More details of this new feature, and other transformation utilities, will be released on the Oracle 
Technology Network (OTN) website (otn.oracle.com) as and when they become available. 

Summary 
Oracle9i Developer Suite contains both Designer and JDeveloper. Use them together to create 
J2EE applications. 
Use Oracle9i Designer to: 

•  Model, generate and capture server objects 
•  Model module definitions 

Use Oracle9i JDeveloper UML models to model, generate and capture: 
•  Class 
•  BC4J 
•  AQ 


